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Chapter 1: Introduction 
 
 

This guide explains how to use CA Performance Management for OpenVMS 
Accounting Chargeback software to generate reports on system use. 

This section contains the following topics: 

Intended Audience (see page 7) 
Conventions (see page 7) 

 

Intended Audience 
The Accounting Chargeback software and this guide are designed specifically 
for the following users: 

■ System managers of OpenVMS systems 

■ System programmers of OpenVMS systems 

■ Computer operators of OpenVMS systems 

■ Software Services personnel 

■ Services engineers involved with OpenVMS systems management 
 

This guide assumes that the user knows the: 

■ OpenVMS operating system 

■ OpenVMS system management 

■ OpenVMS Accounting Utility 

■ OpenVMS Analyze/Disk_Structure Utility 
 

Conventions 
The following conventions are used in this guide: 

 

Convention Meaning  

UPPERCASE Uppercase letters indicate the name of a command, a 
file, a parameter, a procedure, a utility, or an 
abbreviation for a system privilege.  

lowercase In format descriptions, words in lowercase indicate 
parameters or arguments you must supply.  
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Convention Meaning  

user input 

 

system prompts 

system displays 

In interactive examples, this typeface indicates input 
entered by the user, a system prompt, or displayed 
system text. 

. 

. 

.  

Vertical ellipsis points indicate the omission of 
information from an example or command format. The 
information is omitted because it is not important to 
the topic being discussed. 

[ ]  In format descriptions, brackets indicate optional 
elements. You can choose none, one, or all of the 
options. (Brackets are not optional, however, in the 
syntax of a directory name in an OpenVMS file 
specification.) 

,... In format descriptions, horizontal ellipsis points 
indicate additional parameters, values, or other 
information that you can enter separated by commas.  

{ } In format descriptions, braces indicate required 
elements. You must choose one of the elements. 

|  In format descriptions, a vertical bar indicates required 
elements.  You must choose one of the elements. 

( ) In format descriptions, parentheses delimit the 
parameter or argument list. 

Ctrl+x Ctrl+x indicates that you hold down the Ctrl key while 
you press another key or mouse button (indicated here 
by x). 

MB1, MB2, MB3  MB1 indicates the left mouse button.  MB2 indicates 
the middle mouse button.  MB3 indicates the right 
mouse button.  (You can redefine the mouse buttons.) 



 

Chapter 2: Using Accounting 
Chargeback 
 
 

This chapter introduces you to Accounting Chargeback and describes: 

■ Specifying resource prices 

■ Invoking the ADVISE CHARGE_BACK REPORT Command 
 

■ Sample Reports 

■ Reporting on Disk Use Information 

■ Varying Accounting File Contents 
 

Accounting Chargeback uses OpenVMS accounting data to produce system use 
reports. These reports show the charges for various system resources based 
on unit prices that you provide. You can use Accounting Chargeback report as 
an itemized bill or as a general resource use report. 

 

With the Accounting Chargeback you can: 

■ Produce a single report from multiple accounting files created by the 
OpenVMS Accounting Utility on a single node or a cluster system 

■ Charge different prices for resources in different accounting files 
 

■ Charge different prices for resources according to printer queue names 
and accounting files 

 

■ Charge different prices for disk use according to volume names and disk 
use information provided by the OpenVMS Analyze/Disk_Structure Utility 

■ Generate reports on the basis of single jobs, job types, UICs, user 
accounts, and grand totals 
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The following figure shows how Accounting Chargeback works. It creates 
reports using your input and system data. 

 

 
 

Accounting Chargeback uses information from accounting log files that you 
specify. The OpenVMS Accounting Utility creates these log files on an 
individual system or on each node of a cluster. The Accounting Chargeback 
software can read data directly from open accounting files on different nodes. 
Although the main accounting log file, SYS$MANAGER:ACCOUNTNG.DAT, is 
created at system initialization, the OpenVMS Accounting Utility enables you to 
create other data files. 

 

Before generating a report from the accounting data, you choose the system 
resources that you want to charge for and specify unit prices for them. You 
can enter these amounts interactively from the terminal; however, it is usually 
more convenient to place them in a price file. 

 

To report disk use, enter the command ANALYZE/DISK_STRUCTURE/USAGE to 
generate a disk use file for each disk on which you want to report. Append the 
disk use files to one file for the Accounting Chargeback software to process. 

 

The ADVISE CHARGE_BACK REPORT command processes the accounting and 
disk use data with the price file, which contains resource prices. The software 
creates a report showing a detailed breakdown of charges by individual job or 
process, job type, UIC, user name, account name, and grand totals. 
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To use Accounting Chargeback 

1. Determine the amounts to be charged for each type of system resource 
and place these in a price file. See Specifying Resource Prices in the 
following section for information. 

2. Gather disk use information if you want to report on disk allocation 
charges. See Reporting on Disk Use Information later in this chapter. 

3. Process the accounting and disk data with amounts in the price file and 
generate a report. 

This section contains the following topics: 

Specifying Resource Prices (see page 11) 
Invoking the ADVISE CHARGE_BACK REPORT Command (see page 24) 
Sample Report (see page 25) 
Reporting on Disk Use Information (see page 28) 
Varying Accounting File Contents (see page 29) 

 

Specifying Resource Prices 
You can specify prices for resources in two ways: 

■ By listing the prices in a price file 

■ By entering the prices interactively 
 

This chapter explains how to specify prices from a terminal interface. See 
Chapter 3, “Using the DECwindows Interface” for an explanation of how to 
specify prices from the DECwindows interface. 

 

Entering Prices Interactively 

To enter prices from the terminal, enter the command ADVISE CHARGE_BACK 
REPORT without specifying a price-file parameter from the command line. If 
you specify the optional disk-usage parameter, replace the price-file 
parameter with quotation marks (“ “): 

$ ADVISE CHARGE_BACK REPORT account-file-spec “ “ disk-usage-file-spec 
 

The following message is displayed: 

Enter price and control characters below: 
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Enter keywords and values according to this format: 

keyword = value 

For example: 

TITLE = 'Charges for Today'  

PAGEFAULT_PRICE = 0.00008 

When finished, enter Control-Z to exit and save. 
 

Using Prices from a File 

A price file is a list of system resources and the prices you assign to each 
resource. The use of a price file gives you several advantages: 

■ You can create a price file with a text editor. This enables you to make 
corrections more easily than in a command line. 

■ You can specify the file name in the command, which eliminates the need 
to enter each price and enables you to reuse the price file for other 
reports. 

 

■ You can specify how the report will allocate the charges. 

■ You can create multiple price lists within a single file and then select the 
list to be used when you generate the report. 

 

The rules for constructing a price file are  

■ Each line can begin in any column. 

■ The list contains keywords and their values. Most keywords may be 
preceded by identification information. 

 

■ No more than one keyword specification can be placed on the same line, 
and no single keyword specification may be split across lines. 

 

■ Comment text is preceded by an exclamation point (!). 

■ Duplicate keywords are not allowed. 
 

Overview and Example Price File 

As shown in the following table, price file keywords fall into two categories: 
title or resource. Use the TITLE keyword to specify a title for your report and 
the resource keywords to specify prices for system resources. 

 

This table shows an example price file that specifies all allowed keywords. The 
values shown are suggested as a starting point for creating a price list for your 
system. 
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Title Keyword Meaning Default Value 

TITLE Optional report title Title line is not 
printed 

Resource Keywords Meaning Default Value 

BUFFEREDIO_PRICE Buffered I/O operations 0.00000 

CPUSEC_PRICE CPU time 0.00000 

DIRECTIO_PRICE Direct I/O operations 0.00000 

ELAPSEDSEC_PRICE Elapsed time 0.00000 

FAULTIO_PRICE Page read I/O operations 0.00000 

GET_PRICE Symbiont GET operations 0.00000 

IMAGE_PRICE Image activations 0.00000 

MOUNTVOL_PRICE Volume mounts 0.00000 

PAGE_PRICE Pages printed by symbiont 0.00000 

PAGEFAULT_PRICE Page faults 0.00000 

PROCESS_PRICE Process creations 0.00000 

QIO_PRICE Symbiont QIO operations 0.00000 

PRINTJOB_PRICE Print jobs 0.00000 

DISKBLOCK_PRICE Allocated block per UIC 0.00000 

The following example is a price file showing one price for all accounting files: 

TITLE = 'September's System Usage Charges' 

BUFFEREDIO_PRICE = 0.00010 

CPUSEC_PRICE = 0.01000 

DIRECTIO_PRICE = 0.00050 

ELAPSEDSEC_PRICE = 0.00005 

FAULTIO_PRICE = 0.00050 

GET_PRICE = 0.00010 

IMAGE_PRICE = 0.01000 

MOUNTVOL_PRICE = 1.00000 

PAGE_PRICE = 0.02500 

PAGEFAULT_PRICE = 0.00001 

PROCESS_PRICE = 0.10000 

QIO_PRICE = 0.00010 

DISKBLOCK_PRICE = 0.05000 

PRINTJOB_PRICE = 1.00000 
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Specifying a Value for the Report Title Keyword 

The TITLE keyword allows you to create a string that is printed as the title on 
each page of the Charge report. This string can contain up to 80 characters. 

 

If a string is not specified, no title line is printed. If more than 80 characters 
are specified, the title is truncated to 80 characters. Enclose the string in 
single quotes (') as shown in the following example: 

TITLE = 'January's Cluster Resource Charges' 
 

Specifying Values for Resource Keywords 

Accounting Chargeback can produce a report from a number of accounting 
files with different resource prices for each accounting file. To do this, specify 
prices and identification information for resource keywords in a price file. 

The table, later in this section, describes the resource keywords. 
 

You assign a price to a particular resource according to the following format: 

resource_price = value 
 

For example: 

BUFFEREDIO_PRICE = 0.00010 
 

If no value is specified, the default is zero for that resource in all accounting 
files.  

 

Identification information distinguishes the accounting file, printer, or disk for 
which a resource price is to apply. A category is a label that you use to select 
special prices to apply to resources. Much like a hotel price list might have 
different room prices for business travelers, for individuals, and for families, a 
price file can contain different prices for the same resources. 

 

You use a category to link resource prices in the price file to specific 
accounting files. A category is a type of identification information that applies 
to all resource keywords except DISKBLOCK_PRICE. To use pricing categories: 

1. Specify the category along with the keyword in the price file. 

2. Specify the category along with the accounting file in the command line. 
 

See the section, Invoking the ADVISE CHARGE_BACK REPORT Command, later 
in this chapter, which describes the use of categories in the ADVISE 
CHARGE_BACK REPORT command. 
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Keyword Description 

BUFFEREDIO_PRICE The price for each buffered I/O operation 

CPUSEC_PRICE The price for each second of CPU time used 

DIRECTIO_PRICE The price for each direct I/O operation 

ELAPSEDSEC_PRICE The price for each second of elapsed time 
between process creation and process 
deletion 

FAULTIO_PRICE The price for each disk read operation to 
bring into memory or a page fault cluster to 
satisfy a page fault. Typically, this keyword 
has the same value as DIRECTIO_PRICE 

GET_PRICE The price for each RMS $GET done by a print 
symbiont (on the user's behalf) to read a file 
being printed 

IMAGE_PRICE The price for each image activation 

MOUNTVOL_PRICE The price for each volume mount operation 
(handling cost) 

PAGEFAULT_PRICE The price for each page fault 

PROCESS_PRICE The price for each process creation 

QIO_PRICE The price for each $QIO done by a print 
symbiont (on the user's behalf) to send 
characters to the output device. Typically, 
this keyword has the same value as 
BUFFEREDIO_PRICE. 

PRINTJOB_PRICE The price for each print job in the specified 
printer queue 

PAGE_PRICE The price for each page of printed output for 
the specified. This keyword can be preceded 
by a printer queue name as well as a 
category. 

DISKBLOCK_PRICE The price for each allocated block per UIC for 
the specified disk. This keyword can be 
preceded by a volume name only and cannot 
be preceded by a category 
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Identification information is specified depending on how resources are 
charged. Resources can be charged in the following ways: 

■ Identical resource prices can be charged for all accounting files. 

■ Different resource prices can be charged according to accounting files 
based on user-defined criteria such as processor types. 

 

■ Different prices can be charged for print pages according to printer queue 
name and accounting file. 

■ Different prices can be charged for disks based on volume names. 

Each approach is described in the following sections. 
 

Specifying Identical Prices for Accounting Files 

The example in the section, Overview and Example Price File, earlier in this 
chapter, is a price file with one set of prices that can be applied to a number of 
accounting files. No categories are in this file; therefore, you do not need to 
specify categories in the ADVISE CHARGE_BACK REPORT command line. If a 
category is specified for an accounting file in the command, a warning 
message is displayed and price file prices are applied to that accounting file. 

 

Specifying Different Prices for Accounting Files 

A pricing scheme in which a resource's price varies according to the accounting 
file is done through the use of categories. Categories are specified with 
resource keywords in the price file and with accounting files in the command 
line. The section, Invoking the ADVISE CHARGE_BACK REPORT Command, 
later in this chapter, describes how to specify categories in the ADVISE 
CHARGE_BACK REPORT command.  In the price file, you specify different 
resource prices for each category in this format: 

category::resource_keyword = value 
 

The following is an example of pricing by category: 

8800::BUFFEREDIO_PRICE = 0.20 

2000::BUFFEREDIO_PRICE = 0.10 

GREEN::BUFFEREDIO_PRICE = 0.30 
 

Consider the use of categories for the COLOR VAXcluster system: 

 

Node Name VAX Processor Type 

PINK VAX 8800 

AQUA VAX 2000 
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Node Name VAX Processor Type 

PURPLE VAX 8800 

Resources on nodes PINK and PURPLE can be charged at a higher rate than 
the resources on node AQUA. Therefore, each resource in the price file is 
specified with one price for the category 8800 and one price for the category 
2000, as shown in the following example. 

 

This example illustrates a price file showing prices for two categories. 

TITLE = 'System Resource Usage Charges for COLOR Cluster' 

! Default Prices 

BUFFEREDIO_PRICE = 0.00010 

CPUSEC_PRICE = 0.01000 

DIRECTIO_PRICE = 0.00050 

ELAPSEDSEC_PRICE = 0.00005 

FAULTIO_PRICE = 0.00050 

GET_PRICE = 0.00010 

IMAGE_PRICE = 0.01000 

MOUNTVOL_PRICE = 1.00000 

PAGE_PRICE = 0.02500 

PAGEFAULT_PRICE = 0.00001 

PROCESS_PRICE = 0.10000 

QIO_PRICE = 0.00010 

DISKBLOCK_PRICE = 0.05000 

PRINTJOB_PRICE = 1.00000 

!Prices for Nodes PINK and PURPLE 1 
 

8800::BUFFEREDIO_PRICE = 0.00020 

8800::CPUSEC_PRICE = 0.02000 

8800::DIRECTIO_PRICE = 0.00060 

8800::ELAPSEDSEC_PRICE = 0.00006 

8800::FAULTIO_PRICE = 0.00060 

8800::GET_PRICE = 0.00020 

8800::IMAGE_PRICE = 0.02000 

8800::MOUNTVOL_PRICE = 2.00000 

8800::PAGE_PRICE = 0.05000 

8800::PAGEFAULT_PRICE = 0.00002 

8800::PROCESS_PRICE = 0.20000 

8800::QIO_PRICE = 0.00020 

8800::PRINTJOB_PRICE = 2.00000 

!Prices for Node AQUA 2 
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2000::BUFFEREDIO_PRICE = 0.00009 

2000::CPUSEC_PRICE = 0.00900 

2000::DIRECTIO_PRICE = 0.00040 

2000::ELAPSEDSEC_PRICE = 0.00004 

2000::FAULTIO_PRICE = 0.00040 

2000::GET_PRICE = 0.00009 

2000::IMAGE_PRICE = 0.00900 

2000::MOUNTVOL_PRICE = 0.90000 

2000::PAGE_PRICE = 0.01500 

2000::PAGEFAULT_PRICE = 0.00001 

2000::PROCESS_PRICE = 0.09000 

2000::QIO_PRICE = 0.00009 

2000::PRINTJOB_PRICE = 0.90000 
 

1- When /CATEGORY=8800 is specified with accounting files in the ADVISE 
CHARGE_BACK REPORT command line, amounts for all resources preceded by 
the category 8800 in the price file are used to calculate values for those 
accounting files. 

2 - Similarly, when /CATEGORY=2000 is specified with accounting files, 
amounts for all resources preceded by the category 2000 are used to calculate 
values for those accounting files. 

 

Default prices for resources without categories are applied to an accounting 
file for either of the following conditions: 

■ There is no category on the command line. 

■ The category specified does not correspond to categories in the price file. 
 

For a better understanding of how resource prices are charged to accounting 
files, consider the resource prices specified in the next example. 

The following example is a price file showing charges to accounting files: 

TITLE = 'Resource Charges' 

! 

! Default Prices 

! 

BUFFEREDIO_PRICE = 0.00010 1 
 

CPUSEC_PRICE = 0.01000 

 . 

 . 

 . 

ELAPSEDSEC_PRICE = 0.00005 

FAULTIO_PRICE = 0.00050 

GET_PRICE = 0.00010 

IMAGE_PRICE = 0.01000 

MOUNTVOL_PRICE = 1.00000 

PAGE_PRICE = 0.02500 
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PAGEFAULT_PRICE = 0.00001 

PROCESS_PRICE = 0.10000 

QIO_PRICE = 0.00010 

DISKBLOCK_PRICE = 0.05000 

PRINTJOB_PRICE = 1.00000 

! 

!Prices for NODEA 

! 
 

NODEA::BUFFEREDIO_PRICE = 0.00020 

NODEA::CPUSEC_PRICE = 0.02000 

 . 

 . 

 . 

NODEA::ELAPSEDSEC_PRICE = 0.00006 

NODEA::FAULTIO_PRICE = 0.00060 

NODEA::GET_PRICE = 0.00020 

NODEA::IMAGE_PRICE = 0.02000 

NODEA::MOUNTVOL_PRICE = 2.00000 

NODEA::PAGE_PRICE = 0.05000 
 

NODEA::PAGEFAULT_PRICE = 0.00002 

NODEA::PROCESS_PRICE = 0.20000 

NODEA::QIO_PRICE = 0.00020 

NODEA::PRINTJOB_PRICE = 2.00000 

! 

!Prices for NODEB  

! 

NODEB::BUFFEREDIO_PRICE = 0.00009 2 

NODEB::CPUSEC_PRICE = 0.00900 
 

1 - In the following example, the price file does not contain a price 
specification for the DIRECTIO_PRICE keyword; therefore, a price of zero is 
applied to all accounting files for direct I/O. 

 

The categories specified in this example are NODEA and NODEB. When a 
category on the command line does not match any of the categories in the 
price file, the default price-file prices are used. For example, if an accounting 
file in the ADVISE CHARGE_BACK REPORT command has NODEC for a 
category, the resource prices without categories apply to that accounting file 
because NODEC does not match a category. That is, BUFFEREDIO_PRICE is 
0.00010 and CPUSEC_PRICE is 0.01000. 
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The following message is displayed: 

% PSAC-W-NOPRICE Default prices used for CATEGORY NODEC 

Because no price is specified for direct I/O, zero is the default. 

2 - If an accounting file in the ADVISE CHARGE_BACK REPORT command has a 
category of NODEB, the prices specified for NODEB apply to that accounting 
file and the default prices are applied to all other resources. For example, 
BUFFEREDIO_PRICE is 0.00009 and CPUSEC_PRICE is 0.00900. With no entry 
under the NODEB category, ELAPSEDSEC_PRICE is the default price 0.00005. 
DIRECTIO_PRICE is charged as zero because no entry appears in the price file 
with this keyword. 

 

Specifying Different Prices for Print Pages 

Just as you can choose from different queues for printing, you can charge 
different prices for printing based on the queue chosen. You can also charge 
different prices for printing based on account file categories. Accounting 
Chargeback lets you specify different prices for pages printed according to the 
printer queue name and accounting file category. 

Specify categories and printer names according to the following format: 

category::printer_queue_name:PAGE_PRICE = value 
 

This is an example of a page price with a queue name and category: 

8800::SYS$PRINT_LINE:PAGE_PRICE = 0.0200 

For example, you may want to charge more per page for documents printed 
on a PrintServer 40 laser printer than for documents printed on a line printer. 
This charge can vary from system to system, as shown in the following 
example. 

 

If the page price keyword or its price is absent from the price file, the price of 
zero is applied to all of the print queues in any of the accounting files. 
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The example below illustrates price file page prices: 

! 

! Default Prices 

! 

 . 

 . 

 . 

PAGE_PRICE = 0.030001 

! 

! Default Prices by Queue 

! 

 . 

 . 

 . 

LASER_QUEUE:PAGE_PRICE = 0.0400 

! 

! 8800 Prices 

!  

 . 

 . 

 . 

8800::LASER_QUEUE:PAGE_PRICE = 0.05002 

8800::SYS$PRINT_LINE:PAGE_PRICE = 0.0125 

! 

! 2000 Prices 

! 

 . 

 . 

 . 

2000::LASER.QUE:PAGE_PRICE = 0.0250 

2000::SYS$PRINT_LINE:PAGE_PRICE = 0.0125 

1 - If an accounting file has no category in the command line, the pages from 
the LASER_QUEUE are charged at $0.40 per page and all other pages printed 
are charged at $0.03 per page. 

2 - If an accounting file has the category 8800, the pages from the 
LASER_QUEUE queue are charged at $0.05 and the pages from the 
SYS$PRINT_LINE queue are charged at $0.02. All other printer queues in this 
accounting file are charged at $0.03. 
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Specifying Different Prices for Allocated Disk Blocks 

Accounting Chargeback lets you specify different prices for disks by volume 
name. Use the following format:  

volume_name:DISKBLOCK_PRICE = value 

The following is an example of different prices for different volumes: 

SYS_DISK:DISKBLOCK_PRICE = 0.04500 

USER_DISK:DISKBLOCK_PRICE = 0.05500 

BACKUP_DISK:DISKBLOCK_PRICE = 0.05000 
 

The following example illustrates a price file showing prices for different 
volumes. 

TITLE = 'September's System Usage Charges'  

BUFFEREDIO_PRICE = 0.00010  

CPUSEC_PRICE = 0.01000  

DIRECTIO_PRICE = 0.00050  

ELAPSEDSEC_PRICE = 0.00005  

FAULTIO_PRICE = 0.00050  

GET_PRICE = 0.00010  

IMAGE_PRICE = 0.01000  

MOUNTVOL_PRICE = 1.00000  

PAGE_PRICE = 0.02500  

PAGEFAULT_PRICE = 0.00001  

PROCESS_PRICE = 0.10000  

QIO_PRICE = 0.00010  

DISKBLOCK_PRICE = 0.05000 1 

PRINTJOB_PRICE = 1.00000  

SYS_DISK:DISKBLOCK_PRICE = 0.04500  

USER_DISK:DISKBLOCK_PRICE = 0.05500  

BACKUP_DISK:DISKBLOCK_PRICE = 0.07000 

1 - Volumes that do not match a volume name in the price file are charged at 
the rate specified for the keyword DISKBLOCK_PRICE. In the previous 
example, a volume named BOOKS_DISK would be charged at the general 
price of $0.05000. If no general DISKBLOCK_PRICE is specified and the 
volume name does not match one in the price file, then the price of zero is 
applied. 

To report charges for a disk, you must specify a disk usage file containing 
information for that disk in the ADVISE CHARGE_BACK REPORT command line 
as described in Invoking the ADVISE CHARGE_BACK REPORT command. 
Reporting on Disk Use Information describes how to include disk use 
information charges in your report. 
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Specifying Report Details in the Price File 

In a report, charges can be grouped in different ways. To group charges, you 
select report details by entering qualifiers in the price file. The qualifiers are: 

■ JOBS 

■ JOBTYPES 
 

■ UICS 

■ USERS 
 

■ ACCOUNTS 
 

■ GRANDTOT 

■ NO_ZEROS_TOTALS 
 

To select a report detail, enter the selection in the price file in this format: 

PRINT_JOBS = TRUE 
 

To omit a report detail, use this format: 

PRINT_JOBTYPES = FALSE 
 

The following example shows report detail qualifiers in a price file. 

TITLE = 'System Usage Charges'  

BUFFEREDIO_PRICE = 0.000100  

CPUSEC_PRICE = 0.010000  

DIRECTIO_PRICE = 0.000500  

FAULTIO_PRICE = 0.000500  

GET_PRICE = 0.000100  

IMAGE_PRICE = 0.010000  

MOUNTVOL_PRICE = 1.000000  

PAGEFAULT_PRICE = 0.000010  

PROCESS_PRICE = 0.100000  

QIO_PRICE = 0.000100  

PAGE_PRICE = 0.025000  

PRINT_GRANDTOT = TRUE  

PRINT_ACCOUNTS = TRUE  

PRINT_USERS = TRUE  

PRINT_UICS = FALSE  

PRINT_JOBS = FALSE  

PRINT_JOBTYPES = FALSE 
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Precedence of Qualifiers 

Report details can be specified on the command line with the /DETAIL 
qualifier, as well as in a price file. Qualifiers specified on the command line 
override qualifiers in the price files. If report details are not specified, the 
defaults are GRAND, ACCOUNTS, and USERS. 

 

The qualifier for reporting grand totals is specified differently depending on 
where it is used. You use GRANDTOT in a price file, but use GRAND in the 
command line. See Chapter 2, “Accounting Chargeback Commands,” for an 
explanation of the /DETAIL qualifier. 

 

Invoking the ADVISE CHARGE_BACK REPORT Command 
To generate a resource use report, enter a command of the form:   

ADVISE CHARGE_BACK REPORT /qualifier[/...] account-file-spec[,...] -  

[price-file-spec] - 

[disk-usage-file-spec] 

This command accepts three parameters:  

Account file-spec 

The name of the files containing accounting data. The account-file-spec is 
a required parameter that specifies the name of the file containing 
accounting data from the OpenVMS Accounting Utility. You can specify one 
or more accounting files. 

 

Price-file-spec 

The name of the chosen price file containing resource prices and report 
details. The price-file-spec specifies the name of the file that contains 
charges for each billable resource. 

 

Disk-usage-file-spec 

The name of the file containing disk use information. The disk-usage-file-
spec specifies the name of a file containing disk use information from the 
OpenVMS Analyze/Disk_Structure Utility. Run this utility for each disk on 
which you want to report charges. Append the resulting output files to 
form one disk use file. This parameter is optional and need only be present 
for disk use reporting. 

 

You can generate a report for a month, a week, or any period that you choose. 
Use the /ENDING and /BEGINNING qualifiers to specify the period of time for 
which charges are reported. See Chapter 2, “Accounting Chargeback 
Commands,” for a description of all the command qualifiers. 
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The following command generates a report, CHARGE.RPT, for the accounting 
data in ACCOUNT.DAT. Resource prices and report details are read from the 
price file ACCHARGE.TXT. 

$ ADVISE CHARGE_BACK REPORT ACCOUNT.DAT ACCHARGE.TXT 
 

The following command generates a report, ACCOUNT.CHG, from the 
accounting data file ACCOUNT.DAT and the price file ACCHARGE.TXT. Because 
/DETAILS is given without any keywords, default details of GRAND, 
ACCOUNTS, and USERS are reported. 

$ ADVISE CHARGE_BACK REPORT/DETAILS/OUTPUT=ACCOUNT.CHG -  

_$ ACCOUNT.DAT ACCHARGE.TXT 
 

Entering the following command assumes that resource prices are defined for 
the categories GREEN and YELLOW in the price file CHARGE.DAT: 

$ ADVISE CHARGE_BACK REPORT ACCT1.DAT/CATEGORY=GREEN,ACCT2.DAT - 

_$ /CATEGORY=YELLOW,ACCT3.DAT CHARGE.DAT DISK.DAT 
 

The preceding command string indicates: 

■ Resource prices associated with the category GREEN are applied to the 
accounting file ACCT1.DAT. 

■ Resource prices associated with category YELLOW are applied to the 
accounting file ACCT2.DAT. 

 

■ Resources prices specified without categories in CHARGE.DAT are applied 
to the accounting file ACCT3.DAT. If there are no such resource prices, a 
price of zero is applied to all resources in ACCT3.DAT. 

■ The disk volume names in CHARGE.DAT have disk use information in the 
disk use file DISK.DAT. 

Most of the error conditions that can occur when you generate a report are 
reported by standard error messages. 

 

Sample Report 
This section shows a sample report. 

Report Date: 03-FEB-2008 15:57 PSAC Vx.x Page 1 

      CHARGES.RPT 

Usage Period: 02-FEB-2008 10:12:52.17 to 03-FEB-2008 10:49:47.14 
 
Type: Subprocess Single Job Total - File: 1 
UIC: [1,4] 
User: SYSTEM 
Account: 
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Item Description Quantity Unit Price($) Total Price($) 
----------------- -------- ------------- -------------- 
Process Creations 2 0.10000 0.20  
Image Activations 6 0.01000 0.06  
CPU Time 0 00:00:03.22 0.01000 0.03  
Elapsed Time 0 00:00:08.77 0.00000 0.00  
Page Faults 586 0.00001 0.01  
Page Read I/O Operations 20 0.00050 0.01  
Direct I/O Operations 2 0.00050 0.00  
Buffered I/O Operations 41 0.00010 0.00  
 -------------- 
         Total $ 0.31 
 

Type: Interactive Single Job Total - File: 1 

UIC: [1,4] 

User: SYSTEM 

Account: SYSTEM 

Item Description Quantity Unit Price($) Total Price($) 
---------------- -------- ------------- -------------- 
Process Creations 1 0.10000 0.10  
Image Activations 8 0.01000 0.08  
CPU Time 0 00:00:16.85 0.01000 0.17  
Elapsed Time 0 00:01:41.30 0.00000 0.00  
Page Faults 1327 0.00001 0.01  
Page Read I/O Operations 95 0.00050 0.05  
Direct I/O Operations 191 0.00050 0.10  
Buffered I/O Operations 150 0.00010 0.01  
Disks Mounted 1 1.00000 1.00  
 ------------ 
         Total $ 1.53 

 

Report Date: 03-FEB-2008 15:57 PSAC Vx.x Page 3 

      CHARGES.RPT 

 Usage Period: 02-FEB-2008 10:12:52.17 to 03-FEB-2008 10:49:47.14 
 
Type: Subprocess Single Job Total - File: 1 
UIC: [1,4] 
User: SYSTEM 
Account:  
 

Item Description Quantity Unit Price($) Total Price($) 
---------------- -------- ------------- -------------- 
Process Creations 3 0.10000 0.30  
Image Activations 14 0.01000 0.14  
CPU Time 0 00:00:20.06 0.01000 0.20  
Elapsed Time 0 00:01:50.07 0.00000 0.00  
Page Faults 1913 0.00001 0.02  
Page Read I/O Operations 115 0.00050 0.06  
Direct I/O Operations 193 0.00050 0.10  
Buffered I/O Operations 191 0.00010 0.02  
Disks Mounted 1 1.00000 1.00  
           ---------------  
         Total $ 1.84 

Report Date: 03-FEB-2008 15:57 PSAC Vx.x Page 4 

      CHARGES.RPT 
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 Usage Period: 02-FEB-2008 10:12:52.17 to 03-FEB-2008 10:49:47.14 
 

      Grand Total  
 
Item Description Quantity Unit Price($) Total Price($) 
---------------- -------- ------------- -------------- 
Process Creations 3 0.10000 0.30  
Image Activations 14 0.01000 0.14  
CPU Time 0 00:00:20.06 0.01000 0.20  
Elapsed Time 0 00:01:50.07 0.00000 0.00  
Page Faults 1913 0.00001 0.02  
Page Read I/O Operations 115 0.00050 0.06  
Direct I/O Operations 193 0.00050 0.10  
Buffered I/O Operations 191 0.00010 0.02  
Disks Mounted 1 1.00000 1.00  
          ---------------  
        Grand Total $ 1.84 
 
Report Date: 03-FEB-2008 15:57 PSAC Vx.x Page 4 
 
CHARGES.RPT  
Usage Period: 02-FEB-2008 10:12:52.17 to 03-FEB-2008 10:49:47.14 
 
 
Run Statistics: 
-------------- 
 
Accounting file(s): 
 
File Category File name 
 1 <default> ACC2.DAT  
 

Number of accounting records read : 4  
Number of accounting records selected : 3  
 
Command Line: 
 
CHARGE_BACK REPORT ACC2.DAT PRICE.DAT 
Image Performance Statistics:  
 
ELAPSED: 0 00:00:00.95 CPU: 0:00:00.10 BUFIO: 10 DIRIO: 5 FAULTS: 66 
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Reporting on Disk Use Information 
To include disk use information in your Accounting Chargeback report 

1. Create a disk use file for the disks on which you wish to report by using 
the following command:  

ANALYZE/DISK_STRUCTURE/USAGE=[output-file-spec] diskname 

For example: 

$ ANALYZE/DISK_STRUCTURE/USAGE=USER_DISK.DAT USER 

If no file specification is given, the default output file name of USAGE.DAT 
is used. 

2. Append the disk use files into one file using the commands shown in the 
following example: 

$ APPEND DEVD.DAT,USER1.DAT,SYS_2.DAT DISKUSE.DAT 

For your convenience, the Accounting Chargeback software provides a 
command procedure to run and append the files for all the disks on the 
system: 

$ @PSAC$EXAMPLES:PSAC$DISK_USAGE.COM 
 

3. Specify values in the price file for the DISKBLOCK_PRICE keyword for the 
disks on which you wish to report. The following is an example: 

DEVD:DISKBLOCK_PRICE = 0.03000 

USER1:DISKBLOCK_PRICE = 0.02500 

SYS_2:DISKBLOCK_PRICE = 0.03500 
 

4. Invoke the ADVISE CHARGE_BACK REPORT command and specify the 
following items: 

■ Accounting file name 

■ Price file name 

■ Disk use file  

■ At least one of the following keywords for the /DETAILS qualifier: 

GRAND 

ACCOUNTS 

USERS 

UICS 

The following is an example of a command to create a disk use report: 

$ ADVISE CHARGE_BACK REPORT/DETAILS=(USERS,UICS,ACCOUNTS) ACCOUNT.DAT - 

_$ CHARGE.DAT DISKUSE.DAT 
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Varying Accounting File Contents 
By using OpenVMS Accounting Utility qualifiers, you can vary Charge Report 
contents. These qualifiers enable you to create accounting data files of the 
data items you select. This section describes how to charge different prices for 
resources by selecting data based on types, UICs, users, accounts, and so on.   

 

Reporting on Specific Accounting File Components 

To create an accounting file of specific records, use the following qualifiers to 
the ACCOUNTING command:  

■ /TYPE=(print,process) 

■ /OWNER 

■ /PROCESS, /UICS, /USERS, and /ACCOUNTS 

See the OpenVMS Accounting Utility Manual for more information. 

The following section is an example showing how to create files of data 
selected by user name. 

 

Creating Data Files Based on User Name 

To charge for resources based on user name: 

1. Use the OpenVMS command ACCOUNTING with the /USER qualifier to 
create accounting files for the user names for which you want to vary 
resource prices. 

The commands in the following examples create three accounting files: 
one for users Romeo and Juliet, one for users Dickinson and J. Conrad, 
and the other for all the other user names. 

■ This command selects records that match the user names Romeo and 
Juliet: 

$ ACCOUNTING  /BINARY /USER=(ROMEO,JULIET) /OUTPUT=LOVERS.DAT 

■ This command selects records that match the user names Dickinson 
and J. Conrad: 

$ ACCOUNTING /BINARY /USER=(DICKINSON,JCONRAD) /OUTPUT=WRITERS.DAT 

■ This command selects all the records except those that match the 
usernames Romeo, Juliet, Dickinson, and J. Conrad: 

$ ACCOUNTING /BINARY /USER=("-",ROMEO,JULIET,DICKINSON,JCONRAD) -   

_$  /OUTPUT=OTHERS.DAT 
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2. Specify categories and resource prices in the price file for the three 
accounting files, as shown in the following price file segment. 

! Lovers Prices 

LOVERS::BUFFEREDIO_PRICE = 0.0009 

LOVERS::CPUSEC_PRICE = 0.00999 

LOVERS::DIRECTIO_PRICE = 0.00049 

 . 

 . 
 

 . 

! Writers Prices 

WRITERS::BUFFEREDIO_PRICE = 0.00030 

WRITERS::CPUSEC_PRICE = 0.03000 
 

WRITERS::DIRECTIO_PRICE = 0.00080 

 . 

 . 

 . 

! Others Prices 

OTHERS::BUFFEREDIO_PRICE = 0.00010 
 

OTHERS::CPUSEC_PRICE = 0.01000 

OTHERS::DIRECTIO_PRICE = 0.00050 

 . 

 . 

 . 

3. Specify categories for each accounting file in the ADVISE CHARGE_BACK 
REPORT command line, as in the following example: 

$ ADVISE CHARGE_BACK REPORT LOVERS.DAT/CATEGORY=LOVERS,WRITERS.DAT - 

_$ /CATEGORY=WRITERS,OTHERS.DAT/CATEGORY=OTHERS CHARGE.DAT 

 



 

Chapter 3: Using the DECwindows Motif 
Interface 
 
 

This chapter describes how to use the Accounting Chargeback DECwindows 
Motif interface. The interface gives you an easier way to enter the ADVISE 
CHARGE_BACK command. You can select each parameter and qualifier 
individually and let the interface combine these elements. 

This section contains the following topics: 

Starting the DECwindows Motif Interface (see page 31) 
Exiting from the DECwindows Motif Interface (see page 32) 
Controlling the DECwindows Motif Interface (see page 32) 
Selecting Data and Price Files (see page 33) 
Specifying Time Periods and Details for Reports (see page 35) 
Editing Price Files from the Customize Menu (see page 36) 

 

Starting the DECwindows Motif Interface 
To use the DECwindows Motif interface, you do not need to install Accounting 
Chargeback or have it running on a workstation. You run the software from a 
remote node or cluster.  

To start the DECwindows Motif interface 

1. Modify the workstation security to allow access by the remote node. Use 
the Customize menu from the Session Manager window. 

2. Set host to the node or cluster where Accounting Chargeback is installed. 
 

3. Enter this command: 

$ SET DISPLAY/CREATE/NODE=MYNODE 

MYNODE represents the node name of the workstation. 

Enter the following command: 

$ ADVISE CHARGE_BACK REPORT/INTERFACE=DECWINDOWS 
 

The Accounting Chargeback DECwindows Motif interface displays the main 
window, enabling you to select the task you want to perform. 
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Exiting from the DECwindows Motif Interface 
 

The menus in the Accounting Chargeback main window enable you to do the 
following: 

■ Invoke Accounting Chargeback or terminate the interface 

■ Specify accounting data, disk use, and price files 
 

■ Select the time period and report details 

■ Create or edit the price file 

■ View Help 
 

Exiting from the DECwindows Motif Interface 
To exit from the Accounting Chargeback DECwindows Motif interface, pull 
down the Control menu from the main window and select Quit. 

 

Controlling the DECwindows Motif Interface 
Pull down the Control menu and release on the menu item you want. The 
Control menu enables you to: 

■ Create a report using the default report file name 

■ Create a report using a report file name you enter 

■ Quit the Accounting Chargeback DECwindows Motif session 
 

Creating a Report 

To create a report, release on the Create Report menu item. A dialog box 
displays the names of the accounting data, disk use, and price files, and 
creates a report under the default file name CHARGE.RPT. Whenever you enter 
a file name for this report, this name becomes the new default report name. 

 

Creating a Report with a Specified File Name 

To create a report, release on the Create Report As... menu item. The screen 
displays the dialog box shown in the following figure. This dialog box enables 
you to enter the file name for the report. 
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Selecting Data and Price Files 
 

You can enter or change the file name for the report. Click on OK to create the 
report. Click on Cancel to return to the Accounting Chargeback main window 
without creating a report. 

 

Selecting Data and Price Files 
Pull down the Files menu and release on the menu item you want. The Files 
menu enables you to: 

■ Select accounting data files 

■ Select a price file 

■ Select a disk use file 
 

Selecting the Accounting Data Files 

The Accounting Files dialog box enables you to select the accounting data file 
or files, categories, and listing order. 

 

Accessing the Accounting Files Menu 

Pull down the Files menu and release on the Accounting Files... menu item. 
The figure below shows an example of a list of accounting files entered from 
the DECwindows Motif interface 

 
 

Entering File Names 

To enter file names 

1. Type the file name specification for the accounting file on the blank line 
below Accounting File. The flashing cursor (I) indicates where you can type 
the file name. (If the cursor is not flashing, point to the cursor and click 
the left mouse button.) 

2. To specify a category, point to the cursor below Category and click the left 
mouse button. Then type the appropriate category. 
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3. Click the left mouse button on Add. The file name appears in the list box. 
 

4. Repeat this procedure to enter additional files. 

If you want to add an entry similar to an existing entry, you can copy the 
entry to the entry line. To copy, double click on the entry. The entry will 
appear on the entry line, where you can edit the entry to create a new 
entry. 

To remove a file name from the list, point to the name and click the left 
mouse button. Then click on Remove. 

5. When the list is complete, click on Apply. The list is saved and the dialog 
box remains. 

If you click on OK, the list is saved and the dialog box is removed. 

Click on Cancel to cancel the edits made since the last OK. Click on Apply 
and remove the dialog box. 

 

Selecting the Price File 

If you have already created the price file you want to use, you can enter the 
name from the Files menu. To select a price file, release on the Price 
File...menu item. The dialog box is shown below: 

 

Type the name of the price file and click on OK. 
 

Selecting the Disk Use Data File 

To select a disk use file, release on the Disk Usage... File menu item. The 
dialog box shown in the following figure is displayed. 

 

Type the name of the file and click on OK. 
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Specifying Time Periods and Details for Reports 
Pull down the Select menu and release on the menu item you want. The Select 
menu enables you to: 

■ Specify the time period 

■ Specify the report details 
 

Specifying Time Periods 

You can specify the day and time for the reporting period or select from 
standard time periods. To select a time period, release on the Time 
Period...menu item. The dialog box shown in the following figure is displayed. 

 
 

You can select from the following time period options: 

■ Last calendar week 

■ Last calendar month 
 

■ Complete file (the entire time included in the accounting files) 

■ Specific period (a time period that you specify) 

To specify a time period, click on the Specific period option menu and release 
on the selection you want. The selections are shown here: 
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To enter a specific period of time to be covered by the report 

1. Enter the time period in the format shown in the figure below. 

a) Click on the Start Time text field and type the beginning date and 
time. 

b) Click on the End Time text field and type the ending date and time. 

2. Click on OK. The days and times appear in the proper locations. 
 

Report Details 

To select report details, release on the Report Details.... menu item. The 
dialog box shown in this section is displayed. Click on the toggle buttons to 
select the report details that you want. When you have completed your 
selections, click on OK. 

 
 

Editing Price Files from the Customize Menu 
The Customize menu enables you to edit price files. Pull down the Customize 
menu and release on the Prices... menu item. 

The Price File Editor dialog box is displayed 

 
 

36  Accounting Chargeback Administrator Guide 
 



Editing Price Files from the Customize Menu 
 

Working with Price Files 

Pull down the File menu and release on the menu item you want. The File 
menu enables you to: 

■ Open an existing price file 

■ Save the edited file under the default price file name 
 

■ Save the edited file under a name you enter 

■ Apply the edited price file for use in the report 

■ Quit the menu 

After specifying prices, you must select the Apply menu item to use the prices 
for the current report. 

 

Selections for Editing Price Files 

Pull down the Select menu and release on the menu item you want. The Select 
menu enables you to: 

■ Enter a title for the report 

■ Price system resources 
 

■ Price printer pages 

■ Price disk blocks 

■ Specify report details 
 

Entering a Report Title 

To enter a title for the report, pull down the Select menu and release on the 
Report Title menu . . . item. The dialog box shown below is displayed. Type 
the report name and click on OK. 
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Entering Prices for General Resources 

To enter prices 

1. Pull down the Select menu and release on the General Resources . . . 
menu item. 

The screen displays the window shown below. 

2. Select Get from the Resource option menu. 

 
 

For each price you want to enter 

1. Point to the Resource box and hold down the left mouse button. Release 
on the system resource you want. 

2. Click on the line below Price and type the price. 

3. Click on the line below Category. Then type the category you want. If you 
do not want to specify a category for the resource, leave this line blank. 

You can display the entries by category or by resource. Point to the List 
Order By: box and press and release on the choice you want. 

4. To include your entry, click on Add. 

If you want to add an entry similar to an existing entry, you can copy the 
entry to the entry line. To copy, double click on the entry. The entry will 
appear on the entry line, where you can edit the entry to create a new 
entry. 
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To save the completed price list into a file, click on Apply. 

The following figure shows some example prices and categories that have been 
entered. 

 

Entering Prices for Printer Resources 

To enter prices, pull down the Select menu and release on the Printer Pages . . 
. menu item. You can display the entries by category or by queue. Point to the 
List Order By: box and press and release on the choice you want. The 
selections are shown in the following figure. 

 
 

For each price you want to enter 

1. Click on the line below Price and type the price. 

2. Click on the line below Category. Then type the category you want. If you 
do not want to specify a category for the resource, leave this line blank. 

 

3. Click on the line below Queue. Then type in the queue name you want. If 
you do not want to specify an individual printer queue, leave this line 
blank. 

4. To include your entry, click on Add. 

If you want to add an entry similar to an existing entry, you can copy the 
entry to the entry line. To copy, double click on the entry. The entry will 
appear on the entry line where you can edit the entry to create a new 
entry. 
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The following figure shows the printer page dialog box with some sample 
prices. 

 
 

Entering Prices for Allocated Disk Blocks 

To enter prices, pull down the Select menu and release on the Disk Blocks . . . 
menu item. The following figure shows the Disk Blocks Dialog Box with some 
sample prices. 

 
 

For each price you want to enter 

1. Click on the line below Price and type the price. 

2. Click on the line below Category. Then type the category you want. If you 
do not want to specify a category for the resource, leave this line blank. 

 

3. Click on the line below Queue. Then type in the queue name you want. If 
you do not want to specify an individual printer queue, leave this line 
blank. 

You can display the entries by category or by queue. Point to the List 
Order By: box and press and release on the choice you want. 

4. To include your entry, point to Add and release. 

If you want to add an entry similar to an existing entry, you can copy the 
entry to the entry line. To copy, double click on the entry. The entry 
appears on the entry line, where you can edit the entry to create a new 
one. 
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Entering Report Details 

To select report details, pull down the Select menu and release on the Report 
Details . . . menu item. The dialog box shown in the figure below is displayed. 

To select a detail, click on the toggle buttons for the details that you want. If 
you do not specify any details, none will appear in the price file. 

 
 

Qualifiers can be specified in the command line and in a price file. Report 
detail qualifiers specified in the command line override qualifiers in the price 
files. If report details are not specified, the defaults are GRAND, ACCOUNTS, 
and USERS. 
 

 





 

Chapter 4: Accounting Chargeback 
Commands 
 
 

This is a reference chapter for the Accounting Chargeback command syntax at 
the DCL level. Refer to the chapter Using the DECwindows Motif Interface page 
31 for information about performing the Accounting Chargeback functions with 
the DECwindows Motif interface. 

This section contains the following topics: 

ADVISE CHARGE_BACK REPORT (see page 43) 
ADVISE CHARGE_BACK SHOW VERSION (see page 47) 

 

ADVISE CHARGE_BACK REPORT 
Process accounting and disk data by applying values in the price files to 
generate a report. 

 

Format 

ADVISE CHARGE_BACK REPORT account-file-spec[,...] [price-file-spec] [disk-usage-

file-spec] 

 

Command Qualifiers Defaults 

/BEGINNING[=time] /BEGINNING=beginning-of-file 

/DETAILS[=(item[,...])] See description 

/ENDING[=time] /ENDING=end-of-file 

/INTERFACE[=option] /INTERFACE=CHARACTER_CELL | 
DECWINDOWS 

/OUTPUT /OUTPUT=CHARGE.RPT 

/BEGINNING[=time] /BEGINNING=beginning-of-file 

/DETAILS[=(item[,...])] See description 

/ENDING[=time] /ENDING=end-of-file 

/INTERFACE[=option] /INTERFACE=CHARACTER_CELL | 
DECWINDOWS 

/OUTPUT /OUTPUT=CHARGE.RPT 
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Command Qualifiers Defaults 

Positional Qualifier Defaults 

/CATEGORY=category_name None 

Parameters 

account-file-spec[, ... ] 

Specifies the names of one or more accounting data files. This parameter 
is required. 

If you specify more than one accounting file, separate the specifications 
with commas (,). 

price-file-spec 

Specifies the name of a price file containing the prices for each billable 
item. 

To enter prices from the terminal rather than the price file, omit the price-
file parameter from the command line. If the optional disk-usage 
parameter is specified, replace the price-file parameter with quotation 
marks (“ “) 

disk-usage-file-spec 

Specifies the name of a file containing disk use information provided by 
the OpenVMS Analyze/Disk_Structure Utility. 

This parameter is optional and need only be present for disk use reporting. 
 

Restrictions 

You must have access to accounting files. 
 

Prompts 

Enter price and control parameters below: 
 

Description 

The ADVISE CHARGE_BACK REPORT command processes the accounting and 
disk usage data with the price file containing resource prices. It outputs a 
report showing a detailed breakdown of charges by individual job or process, 
job type, UIC, user name, account name, and grand totals. 
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Command Qualifiers 
/BEGINNING[=time] 

Controls whether only those records dated later than the specified time are 
selected. You can specify an absolute time, a delta time, or a combination 
of the two. If you omit this qualifier from the command line or if you do 
not specify the time, records will be selected starting with the first record 
in the file. 

Records are recorded in the accounting log file at time of process 
termination only. The beginning and ending times are bounds on these 
record times. 

/DETAILS[=(item[, ... ])] 

Specifies the report details to be printed. You can specify any of the 
following keywords: 

 

 

Keyword Meaning 

JOBS Reports on each individual job or process 

JOBTYPES Reports totals for each unique combination of 
account, user name, UIC, and job type. The 
job types are batch, detached, interactive, 
network,subprocess, and print 

UICS Reports totals for each unique combination of 
account, user name, and UIC. 

USERS1 Reports totals for each unique combination of 
account and user name 

ACCOUNTS1 Reports totals for each account 

GRAND Reports the grand total for each accounting 
file 

NO_ZEROS_TOTALS Does not print resource fields with zero unit 
prices 

1 - Disk use is recorded by UIC. Disk use totals for a user or an account will 
occur only if the UIC associated with the user is in both the disk use file and 
the accounting file. 
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/ENDING[=time] 

Controls whether only those records dated up to and including the 
specified time are selected. You can specify an absolute time, delta time, 
or a combination of the two. If you omit the /ENDING qualifier from the 
command line or if you do not specify the time, the last record in the 
accounting file will be the final record processed. 

Records are recorded in the accounting log file at time of process 
termination only. The beginning and ending times are bounds on these 
record times. 

 

/INTERFACE=DECWINDOWS 

Starts the Accounting Chargeback DECwindows Motif interface. The default 
/INTERFACE=CHARACTER_CELL enables you to enter the command as a 
DCL command string. 

/OUTPUT[=file-spec] 

Specifies the name of the report file. If you omit the /OUTPUT qualifier or 
the file specification, then /OUTPUT=CHARGE.RPT is assumed. 

 

Positional Qualifier 

/CATEGORY=category-name 

Use this qualifier only after the account-file parameter. This qualifier links 
a set of resource prices in the price file with the specified accounting file 
through a common category name. 

 

Examples 

$ ADVISE CHARGE_BACK REPORT ACCOUNT.DAT DECPS_CHARGE.TXT 

This command generates a report, CHARGE.RPT, for the accounting data in 
ACCOUNT.DAT. Resource prices and report details are read from the price 
file DECPS_CHARGE.TXT. 

$ ADVISE CHARGE_BACK REPORT/OUTPUT=ACCOUNT.CHG - _$ EXTRACT.DAT DECPS_CHARGE.TXT 

This command generates a report ACCOUNT.CHG from the accounting data 
file EXTRACT.DAT and the price file DECPS_CHARGE.TXT. Because the 
/DETAILS qualifier is not in the command, default details of GRAND, 
ACCOUNTS, and USERS are reported. 
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$ ADVISE CHARGE_BACK REPORT ACCT1.DAT/CATEGORY=GREEN, -  

_$ ACCT2.DAT/CATEGORY=YELLOW,ACCT3.DAT CHARGE.DAT DISK.DAT 

In this command, the resource prices associated with the category GREEN 
are applied to the accounting file ACCT1.DAT. The resource prices 
associated with the category YELLOW are applied to the accounting file 
ACCT2.DAT. The resource prices specified without categories in 
CHARGE.DAT are applied to the accounting file ACCT3.DAT. If there are no 
such resource prices, a price of zero is applied to all resources in 
ACCT3.DAT. The disk volume names in CHARGE.DAT have disk use 
information in the file DISK.DAT.  

 

ADVISE CHARGE_BACK SHOW VERSION 
Displays the version of the Accounting Chargeback software. 

 

Format 

ADVISE CHARGE_BACK SHOW VERSION 
 





 

Appendix A: Error Messages 
 
 

This appendix describes the format of the online error messages. It explains 
how to view the list of messages and get help with errors. 

The figure below shows the parts of a sample message. 
 

PSAC
Message
Delimeter

Fac ility
Coder

Severity
Code

Message
Identific a tion
Code

 %     PSAC -E- BADNAME, missing or inva lid  name/ keyword  in line  
 

The following table defines the severity codes that are assigned to messages. 

 

Severity Code Explanation 

I INFORMATIONAL:  The software sometimes provides 
additional information about an action. 

W WARNING:  The command may have performed some, 
but not all, of a requested action. Verify the command 
or output. 

E ERROR:  The output or program result is incorrect, but 
the software will attempt to continue execution. 

S SEVERE:  A fatal error occurred; the software 
terminates execution of the request. 

F FATAL:  A fatal error occurred; the software terminates 
execution of the request. 
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To display messages from the DCL level (command line), enter: 

$ HELP ADVISE CHARGE_BACK ERRORS identification-code 

Each description includes an explanation and recovery procedure. 

To view the list of all messages, enter: 

$ HELP ADVISE CHARGE_BACK ERRORS 

Messages are listed alphabetically by the identification code that precedes 
each message. 
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